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Lab 2 Coordinate Reference Systems (CRS) 

--------------------------------------------------------------------------------------------------------------------------- ------------- 

The Lab material is based on course materials “Introduction to Geospatial Technology” from  

 FOSS4G GeoAcademy curriculum (Creative Commons Attribution 3.0 Unported license). 

---------------------------------------------------------------------------------------------------------------------------------------- 

Before you start: 

1) Create the folder on the local C:\Users\Your_Name\Spatial_Data_Studio\Lab_2 

2) Under the folder Lab_2, create folders original, working, and final.  

3) Download datasets for this lab session from Moodle (Lab_2_datasets.zip) and put them into 

folder original. 

4) Unzip all the files and then delete zipped file to clean up space on the disk.  

5) Copy all files to working and in the next steps only use files in the working folder. 

Introduction  
In this lab, you will explore the effects of various map projections on the characteristics of a map 

using QGIS. 

This lab will focus primarily on shape and area distortions and will examine projections useful for 

mapping on the global scale as well as on the national level. 

This lab includes the following tasks: 

• Task 1 – Setting map projections and coordinate systems in QGIS 

• Task 2 – Exploring world map projections 

• Task 3 – Exploring map distortions by measuring distances 

• Task 4 – Defining and changing the coordinate system of the layers 

• Task 5 – Exploring national map projections 

• Task 6 – Exploring the Universal Transverse Mercator (UTM) coordinate system 

• Task 7 – Independent task 

 

Objective: Explore and understand map projections and coordinate systems 
The map projection is a fundamental part of the mapping process, and provides the backbone, or 

framework, for the map. It is important for the GIS specialist to understand the qualities of the 

mapped region that are preserved by a given projection, and the qualities that will be distorted or 

skewed. Additionally, for cartographers, selection of an appropriate map projection is a crucial part 

of the map design process. This is because we are all used to seeing different parts of the world 

mapped using specific standard projections that make these areas “look right”. 

The transformation of the ellipsoid shape of the earth onto a two-dimensional surface cannot be 

accomplished without some element of distortion, through shearing, tearing, or compression (as 

discussed in the text). For mapping small Earth areas (large-scale mapping), projection is not a major 

issue, but as the scale becomes smaller, as in the mapping of continents or subcontinents, distortion 

becomes a significant factor. Distortion of area, shape, distance, and direction become properties to 

consider. It is impossible for one projection to maintain all of these properties simultaneously. 

http://spatialquerylab.com/foss4g-academy-curriculum/
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Projections are classified according to the properties they preserve. Equal-area (or equivalent) maps, 

for example, preserve area relationships, but tend to lose conformality (preservation of shape). 

Conformal projections, on the other hand, maintain shape over small areas but produce areal 

distortion. In thematic mapping, it is important to maintain correct area properties. Therefore, shape 

is at times compromised through the choice of an equivalent projection. For small-scale maps, in 

fact, conformality cannot be maintained over the entire area; rather, the projection may preserve 

shape best along a standard line, with shape distortion increasing with distance from the line. 

Another property to consider is distance preservation (equidistance), which preserves distance 

measurements along great circle arcs. Finally, direction preservation maintains correct direction from 

one central point to all other points. 

There are hundreds of possible projections from which to choose. Some distort less in certain ways 

than others. It is up to the map designer to select the projection that produces the least amount of 

unwanted distortion. Many computer mapping software packages now allow the GIS specialist to 

easily switch between various projections, allowing the choice of the one most appropriate. In the 

selection of a projection, several key elements must be considered: 

• Projection properties – Are the properties of the projection suitable to the map’s purpose? 
Considering the properties of shape, distance, direction, and area, which ones must be 
preserved, and which can be sacrificed? Or is a compromise of all four the best choice? 

• Deformational patterns – Is the amount of deformation acceptable? 

• Projection center – Can the projection be centered easily on the area being mapped? 

• Familiarity – Is the appearance of the map recognizable to the map reader or will it detract from 
the map’s purpose? 

 

 

Task 1 – Setting map projections and coordinate systems in QGIS 
In this task, you will explore the effects of various projections on the characteristics of a map. We will 

focus primarily on shape and area distortions. We will examine projections useful for mapping on the 

global scale. 

1. Open QGIS project World_View.qgz by clicking Project →Open. You should see the map 

shown in Figure below. World_View.qgz is a QGIS project file. You should have world 

countries, three cities (Atlanta, Cape Town and Alice Springs) and circles layer in the project 

open. The circles (Tissot’s indicatrices1) will be used in this exercise for illustrating the areal 

and shape distortion that occurs with various projections. If these circles were displayed on a 

globe, they would be perfect circles. 

 
1 In the nineteenth century, Nicolas Auguste Tissot developed a method to analyse map projection distortion. Small circles on the earth's 
surface are projected using different projection types. The resulting ellipse of distortion, or indicatrix, shows the amount and type of 
distortion at the location of the ellipse. 
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2. To better visualise the effect of different projections, we will add graticule to the map. Use 

Create grid tool from the Processing toolbox to create a grid with 10*10 degree spacing (see 

parameters on the figure below) and covering the entire globe.  

 

3. You should now have grid covering the whole globe. As the grid consists of polygons then 

you should change the fill color to transparent to make it actually looking like graticule. 
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Change the grid fill colour transparent from the Symbology and you should have a result 

similar to this: 

 
 

4. Check the Coordinate System of the Cities1, Circles and Cntry94 layers by right-clicking on the 

layer name and choosing Properties→Information (see CRS). What is the coordinate system 

of the layers? 

 

5. Check the CRS of the current QGIS project’s (qgz) from the status panel or from the menu 

Project→Properties→CRS. Notice that the map project’s view’s coordinate system is set to 

WGS 84. When QGIS is started with 

a new, empty map, the coordinate 

system for the project is 

automatically WGS 84. But the first 

layer added to an empty project 

sets the coordinate system for the 

project (on-the-fly (OTF) 

transformation is used), but you 

can change it if necessary. Another 

thing that you might notice is that 

WGS 84 is an unprojected 

coordinate system but you still see 

it as plane and not a sphere. 

Although a projection has not yet 

been chosen by the user, the display is essentially a Plate Carree projection which is always 

used as default projection to display data that is in a geographic coordinate system if a user 
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does not define otherwise. In a Plate Carrée projection2, linear scale, area, and shape are all 

distorted increasingly toward the poles as demonstrated with the Circles theme.  

6. On-the-fly transformation enables to add subsequent layers so that they are automatically 

displayed using the project’s coordinate system as long as the data source's coordinate 

system is defined. The map layer’s CRS does not need to be the same as project’s CRS. Let’s 

try this out. Add from your working folder estonia.shp. Estonia should automatically nicely 

place to it’s correct location. Check the CRS of estonia.shp and you should see that it is not 

WGS 84. Thanks to the OTF transformation you can see layers with different CRS in correct 

place, and for viewing and visualising the data this is fine. However, once you start to 

perform spatial analysis then it is better to have all the data layers in the same projection.  

7. Let’s remove the project’s CRS by clicking on the CRS button 

in the lower ribbon. This will directly open Project’s 

Properties’ CRS tab. Check the “No CRS (or unknown/non-

Earth projection)”3 and click OK. On the ribbon there should 

now be displayed “no CRS” symbol: . Remove the 

estonia.shp from the project and add it back again. What 

happened? Can you find Estonia? If not then use Zoom Full 

. You can see that Estonia and world are not in correct size proportions nor location. This 

is because the project does not have any CRS and OTF can’t take place. Switch on the 

project’s CRS again to WGS 84 (EPSG 43264) and Estonia should automatically shift to its 

correct location. 

 

Task 2 – Exploring world map projections 
Let’s examine couple of world map projections. The most common projection over the past centuries 

is Mercator. The Mercator projection was designed for marine navigation and gives all straight lines 

on the map as lines of constant compass bearing. For global scale thematic maps, however, the 

Mercator has too much areal distortion for accurate use. 

1. Let’s change the project’s CRS to the World Mercator projection (EPSG 3395) from the status 

bar lower right corner. Notice how your map changed. Your circles are now circles 

everywhere but the their size is considerably different. The Mercator projection, a conformal 

projection (except at the poles), has straight meridians and parallels that intersect at right 

angles. Scale is truest along the equator, and becomes more distorted at higher latitudes, as 

 
2 Also known as equirectangular, equidistant cylindrical, simple cylindrical, or rectangular, this projection is very simple to construct 

because it forms a grid of equal rectangles. Because of its simple calculations, its usage was more common in the past. In this projection, 
the polar regions are less distorted in scale and area than they are in the Mercator projection (ESRI). In particular, the Plate Carrée has 
become a standard for global raster datasets, such as Celestia and NASA World Wind, because of the particularly simple relationship 
between the position of an image pixel on the map and its corresponding geographic location on Earth (Wiki). 
3 Checking this setting will disable ALL projection handling within the QGIS project, causing all layers and map coordinates to be treated as 

simple 2D Cartesian coordinates, with no relation to positions on the Earth’s surface. It can be used to guess a layer CRS (based on its raw 
coordinates or when using QGIS for non earth uses like role-playing game maps, building mapping or microscopic stuff. In this case: (1) No 
reprojection is done while rendering the layers: features are just drawn using their raw coordinates; (2) The ellipsoid is locked out and 
forced to None/Planimetric; (3) The distance and area units, and the coordinate display are locked out and forced to “unknown units”; all 
measurements are done in unknown map units, and no conversion is possible. Source: QGIS Documentation 
4 EPSG Geodetic Parameter Dataset (also EPSG registry) is a public registry of geodetic datums, spatial reference systems, Earth ellipsoids, 

coordinate transformations and related units of measurement. Each entity is assigned an EPSG code between 1024-32767, along with a 
standard machine-readable well-known text (WKT) representation. (Wiki) The EPSG codes are unique and they are very useful to use for 
searching and identifying the CRS-s in GIS programmes. 

https://docs.qgis.org/3.16/en/docs/user_manual/working_with_projections/working_with_projections.html?highlight=coordinate%20reference#project-coordinate-reference-systems
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evidenced by the increasing size of the circles. The Mercator is best for larger scale maps5 of 

areas at low latitude. Small-scale maps have much distortion of area and distance. The 

Mercator map is much less desirable for mapping continents than other projections as it has 

significant distortion and can promote geographical misconceptions. In general, 

rectangular maps are not recommended for use in mapping the world. Equivalency (the 

property of equal area) and conformality are better preserved using non-rectangular maps.  

 

2. Let’s now explore a map projection more suitable for mapping the entire world: the Eckert IV 

projection. The Eckert IV map projection is an equal-area pseudocylindrical map projection 

with straight parallel latitude lines and equally spaced meridians. Change the CRS of the 

project to the Eckert IV projection (World_Eckert_IV ESRI: 54012). Notice how your map 

(graticule, circles) changed. How did the graticule change? What happened to the cirles? The 

circles are not anymore circles but their area should be more or less the same. The Eckert IV 

is useful for world maps as it is equal-area and is pleasing to the eye. Its standard parallels 

are at 40° 30’N and 40° 30’S. This map is only distortion free where the standard parallels 

intersect the central meridian. 

 
5 A map is classified as small scale or large scale or sometimes medium scale. Large scale maps are usually 1:0 – 1:600 000 and represent 

for example town. Medium scale maps are usually 1:600 000 – 1:2 000 000 and mostly a whole country maps are in this range. Small scale 
maps are 1:2 000 000 – 1:∞ and world or regions are mapped in this scale. (Wiki) 
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3. Find another equal-area projection suitable for the whole world that is not mentioned in this 

tutorial or lecture. Change your project’s CRS into selected map projection and create a map 

of your home country’s location in the world and add it to your independent task’s report 

(see Independent task in the end of this tutorial).  

 

Task 3 – Exploring map distortions by measuring distances 
 

Now we will do some distance measurements on different CRS’s to see how CRS affects the 

distances. We will measure distances between Atlanta, Cape Town and Alice Springs.  

1. First, switch make sure that your project’s CRS is WGS 84 (EPSG 4326). If it is not then switch 

to WGS 84.  

2. Turn the snapping on from Snapping Toolbar by clicking on 

magnet button . If you don’t have the toolbar opened, 

choose from the menu View→Toolbars→Snapping 

Toolbar and it should appear. Make sure that it’s activated 

(should be grayish). Then switch snapping to Active layer 

only to ensure that your mouse cursor would snap only 

to the city points and not other layers. Snapping helps to 

automatically attach your cursor to geometric objects so 

that they are properly connected and less errors happens 

in digitalising or measuring distances.  

3. Now click on the Measure tool . The Measure window 

will appear. Switch the measurement to Cartesian and 

switch your measurement units from map units to 

kilometres. Click on the cities1 layer in the layer panel to 

make it active (important for snapping).  Click on the 
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point for Atlanta, in the United States (if you snapping is 

switched on correctly then a small rectangle should appear 

around the point). Move the cursor to the point for Cape Town, 

South Africa, then click on the point and right-click to end the 

line. The distance between Atlanta and South Africa will be 

displayed in kilometres.  

What distance did you get? Please fill the Quiz Lab 2 Q5 in 

Moodle. 

4. Switch the measurement to Ellipsoidal in the Measure window. Leave units to kilometres. 

Perform the measurement between Atlanta and Cape Town again. What result did you get? 

The result should be 13067 km which is the actual true distance as it is  done one the sphere 

and avoiding the distortions caused by the projection (currently Plate Carree). The distance 

calculation on a sphere is done by using the haversine formula. It determines the great-circle 

distance between two points on a sphere given their longitudes and latitudes (Wiki). The 

distance measurement between two geographic locations on Earth is always the most 

accurate if using haversine formula. 

What about equidistant projections? They should be showing the distances accurately. 

Switch your project’s CRS to World Azimuthal Equidistant (ESRI: 54032). Measure the 

ellipsoidal distance from Atlanta to Cape Town in kilometres. You should again receive 13067 

km because the measurement is being done independently from the projection. Now 

measure the cartesian distance in kilometres.  

What distance did you get? Please fill the Quiz Lab 2 Q6 in Moodle.  

It should be closer to the ellipsoidal distance than the value you obtained when performing 

cartesian measurement on WGS 84 (Plate Carree) but it is still not accurate enough. This is 

because the equidistant projections show only correct measurements if the projection is 

centered to the origin of the measurement. In our case either to Atlanta or to Cape Town. 

Otherwise, the result is very wrong even in equidistant projection. 

5. Let’s center our current equidistant projection to Atlanta and see if this will enable to 

measure the cartesian distance correctly. For that, we need to define our CRS based on the 

existing World Azimuthal Equidistant projection and change it’s latitude and longitude of 

origin to Atlanta. For that, we need to know Atlanta’s coordinates. Switch your project’s CRS 

to WGS 84 and open the attribute 

table of cities1.shp. Switch on 

editing mode  and open field 

calculator  . Create a new field 

with name “X” and the field type 

Decimal number. Under Geometry 

group find function called “$X”. This 

returns the coordinates of the 

features to the new field. Click OK. X 

field with longitude is added to the 

table. Repeat the procedure for Y 

and use function “$Y”. This will add 

latitude to the attribute table. 

Switch off the editing mode by 
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clicking  and save the changes. Now you have Atlanta’s coordinates and you can create a 

custom CRS. 

6. From the  main menu choose Settings→Custom 

Projections…  Click Add new CRS  and name 

your new projection my_equidistant_atlanta. 

Keep the format as WKT and to bring in the 

existing World Azimuthal Equidistant projection 

WKT click on the Copy parameters from existing 

CRS button . Choose 

World_Azimuthal_Equidistant (ESRI: 54032) and 

click ok. The parameters window should be 

filled with the  respective parameters.  

7. Atlanta’s coordinates are X = -84.3492 and  Y = 

33.7957 (4 places after comma is more than 

enough). Scroll down in the Parameter’s 

window until you find "Latitude of natural 

origin" and "Longitude of natural origin". 

Change the Latitude and Longitude of natural 

origin to Atlana’s coordinates. You can now try 

to click Validate and it should say that WKT string is valid. However, if you click OK then it 

gives you an error because there is already projection definition with ID ESRI: 54032. 

Therefore, you need to change the ID. Scroll down in the parameters and find the ID in the 

end. Delete “ID["ESRI",54032]” and click OK. Your defined CRS should be now ready. Switch 

your project’s CRS to your custom defined CRS. You can find it by the name 

(my_equidistant_atlanta). Your map should now be centered to Atlanta. 
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8. Perform the distance measurement from Atlanta to Cape Town in Cartesian system. What 

result did you get? It should be exactly same as ellipsoidal. Therefore, you can see that 

measurements on equidistant projections can be only correct if centered to the 

measurement point of origin. 

9. Let’s now measure distance between Atlanta and Alice Springs. First, switch your project’s 

CRS to WGS 84 (EPSG: 4326). Perform the measurement in cartesian and ellipsoidal. What 

result did you receive in both? 

 Please fill the Quiz Lab 2 Q7 and Q8 in Moodle. 

There is very big difference between ellipsoidal and cartesian measurement. This time is not 

fully the problem of the map projection distortion.  Cartesian distance is not the actual 

distance between Atlanta and Alice Springs. Since in cartesian system QGIS measures directly 

between Atlanta and Alice Springs (along your measure line) heading East from Atlanta. With 

this projection and centering, QGIS does not know that the “World is round”. With the 

Cartesian method the distance between these two cities is measured “on the flat Earth”. 

What it should do is measure to Alice Springs by heading West from Atlanta instead of East 

since heading West is a shorter distance than heading East. Something like this: 

 
 

10. Let’s see if switching the CRS to our defined CRS which is centered to Atlanta would improve 

the measurement. Switch your project’s CRS to my_equidistant_atlanta that you created in 

the previous step. Measure the distance in cartesian system. You should now receive the 

same value as in ellipsoidal system. 

Task 4 – Defining and changing the coordinate system of the layers 
Although we changed the project’s CRS, the coordinate system of the layers remained unchanged. In 

this task, we will look how you can change your datasets from one coordinate system to another and 

define coordinate systems if they are not set in the file properties.  

Defining spatial reference system (coordinate system) of the layers 

In some cases, layer(s) may have no spatial reference system information. If there isn't enough 
information, QGIS will be unable to project the data in each layer and display it correctly. In this case, 
you'll have to supply the necessary coordinate system information yourself. Generally, if you have a 
layer whose dataset does not have a coordinate system defined and you know which coordinate 
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system it is using, you should use the Define Shapefile Projection tool for shp files and Assign 
Projection for gpkg files in Processing Toolbox to assign projection information to your data. This tool 
overwrites the coordinate system information (map projection and datum) stored with a dataset. 
The only use for this tool is for datasets that have an unknown or incorrect coordinate system 
defined i.e., the geometries are not reprojected, they are just assigned to a different CRS. If you do 
not know the coordinate system of the layer then please do not use the tool, it will make your data 
unusable if you choose a wrong coordinate system. 

If you do not know the spatial reference system of your dataset then there are some simple rules 
how you could be very likely to identify the spatial reference system by simply looking at data: 

1) if your data is in geographic coordinates and originates from GPS or remote sensing sources then it 
is very likely WGS84. 

2) if your data is in projected coordinates and it is about some specific country then it is very likely in 
the national coordinate system of this country. 

1. For the shp-files, the spatial reference system is stored in the *.prj file. "PRJ" files contain an 
entire spatial reference, not just a projection. Explore the contents of Cntry94.prj by right-
clicking on the file in Windows Explorer and choose Edit with Notepad or Edit. As you see, 
the *.prj file is just text file where the spatial reference system information is stored. 

2. Let’s do a little experiment. Set the project’s CRS back to WGS84 (EPSG:4326). Remove 
Cntry94 from the Layers List (right-click on the layer name and choose “Remove Layer”). Save 
your project World_view.qgz. Delete the file Cntry94.prj. Add the same layer again to the 
project. The Cntry94 should open nicely and still show in the right place. 

3. Change the project’s CRS into Eckert IV. What happened? Please answer the Quiz Lab 2 Q9 
in Moodle. 

4. As we know that the spatial reference system of 
Cntry94 is WGS84 then we can define it by using 
Define Shapefile Projection tool. Open Processing 
Toolbox from menu the Processing Toolbox or by 

clicking on  button. Use search to find Define 
Shapefile Projection tool and define the spatial 
reference system for Cntry94 as WGS84. What 
happened? Check the working folder in Windows 
Explorer, do you find a new Cntry94.prj file? 

 

Transforming (projecting) the spatial reference system of the layers 

If you want to change the coordinate system of the layers or project geographic coordinate system to 
projected coordinate system, you need to use Reproject Layer tool. The "Reproject Layer" tool is 
really a Spatial Reference System transformation tool which applies mathematical functions to 
transform data from one CRS to another. For raster layers you should use GDAL Wrap (reproject). 

1. Use search to find Reproject Layer tool from 
the Processing Toolbox and project layer 
cities1.shp to Eckert IV (EPSG 54012). Save it 
as a new file with suitable name. 

2. Project also layers Cntry94 and Circles to 
Eckert IV. 
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3. Save your project. 

4. Open a new empty project . Add your projected layers to the new project. Check the 
coordinate system of the project (on the status bar lower corner you can see the EPSG code). 
What is the coordinate system? Please answer the Quiz Lab 2 Q10 in Moodle.  

5. Change the project’s CRS to Mercator (EPSG 3395). How did the map change? Check the CRS 
of the layers. Did the coordinate system of the layer change? 

6. Save and close the project. 

 

Task 4 – Exploring national map projections  
Projections suitable for mapping the world are not necessarily the best for mapping smaller areas, 

such as continents or countries. When mapping at such a scale in the mid-latitudes it is important to 

use a projection that centers on the area being mapped and has a standard line, or lines, passing 

through the area being mapped. 

In this task, we will look at a map of the contiguous United States using a few different projections. 

Country_View.qgz is an unprojected map of the lower 48 states comprised of three themes: United 

States, LA & NYC, and Circle (centered on -97.50, 39.00). You can see it does not look quite right 

given the default projection. The circle shows some obvious skewing. 

 

The distance property is more difficult to judge. Let’s do some measurements. 

1. As before use the Measure tool to measure the distance between Los Angeles and New York 

City in kilometers in cartesian and ellipsoidal system. Don’t forget to switch on the snapping 

on the active layer. The ellipsoidal distance should be accurate: 3939 km. Cartesian, however, 

is significantly off by almost a thousand kilometres.  
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2. Switch the project’s CRS to the Eckert IV projection. The Eckert IV did a nice job with the 

whole world, but we will see how it fares with a single mid-latitude country. 

 

 

There clearly is a great deal of distortion using this projection, most obviously the shearing. 

Part of the problem lies in the fact that this projection is centered at 0 degrees longitude.  

3. Let’s center the Eckert IV projection on the United States by creating a custom CRS based on 

the World Eckert IV projection. Use the instructions from Task 3 and re-center the World 

Eckert IV projection (ESRI 54012). This will center the projection down the middle of the 

country. To accomplish this, replace “Longitude of origin” value 0 with -96.0 (essentially 

replacing the central meridian of 0 with -96.0). Name your projection “my_eckert_IV_US”. 

4. Switch your project’s CRS to your new custom CRS “my_eckert_IV_US”. How did the map 

change?  
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This is a distinct improvement in shape, but there is still some skewing. The Eckert IV 

projection is primarily used for mapping the entire world. For mapping large countries, at mid-

latitudes, such as the United States, other projections are more appropriate. The Lambert 

azimuthal, Albers equal-area, Bonne equal-area, and Lambert conformal conic projections are 

examples of suitable projections for mapping the entire U.S. Because it has two standard 

parallels, the Albers equal-area projection is particularly good for larger countries with a 

significant east-west extent. Let’s try Albers on our map. 

5. Switch the project’s CRS to USA_Contiguous_Albers_Equal_Area_Conic (ESRI: 102003). The 

Albers conic projection has low scale distortion for an area the size of the U.S. As the area being 

mapped decreases in size, distortion is less of an issue. 

 

 

6. Let’s try another map projection to see what changes. Switch project’s CRS to 

USA_Contiguous_Lambert_Conformal_Conic (ESRI: 102004). Not too much changed 

between Albers and Lambert. They are both similar map projections. The conic projections 

function quite well for mapping the larger states in the U.S. In terms of thematic mapping, 

it is important that maps at this scale are equal-area. Any other properties important to the 

particular map should also be considered when selecting a proper projection.  

7. Save and close. 

 

Task 5 – Exploring the Universal Transverse Mercator (UTM) Coordinate System 
The Universal Transverse Mercator (UTM) grid (shown in the figure below) is a plane coordinate 

system that spans almost the entire globe. It is probably the best-known plane coordinate system of 

international scope. For the UTM system, the globe is divided into sixty zones, each comprised of six 

degrees of longitude. Each zone has its own central meridian. The limits of each zone are 84 degrees 

north and 80 degrees south. UTM uses the Transverse Mercator projection that can map a region of 

large north-south extent with low distortion. The zones are numbered 1 to 60, where zone 1 begins 
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at -180° Longitude and zones increase heading East back to +180° where zone 60 ends. All zones are 

also divided by equator into N and S. 

 

1. Open again World_View.qgz. Switch your project’s CRS to WGS 84.  Add UTM_zones.shp to 
your map view and make the fill colour of the zones transparent.  

 
2. What UTM zone does your home country/county/state fall into? Hint: you can use Identify 

Features tool to find out.  

3. Coordinate systems can be also searched based on the classification which can be useful if 
you don’t know the exact EPSG that you are looking for but you do know the region and 
properties, for example global WGS84 UTM. Open project’s CRS and first check the “Hide 
deprecated CRSs” which helps to reduce the list and avoid choosing an CRS that is out of 
date. Then scroll up in the Coordinate Reference System list and close the Geographic 
Coordinate System group by clicking on the arrow in front of the group name as we know 
that UTM is projected CRS and therefore we should not search from geographic CRS-s. 
Projected CRS-s are grouped by projection properties or names. Close some of them and you 
can see how many different CRS-s there are6. Scroll down until you find WGS84 UTM zones. 
WGS84 UTM N has EPSG codes from 32601 to 32660 and UTM S has EPSG codes from 32701 
to 32760. 

 
6 QGIS has support for approximately 7000 known CRSs (QGIS Documentation) 

https://docs.qgis.org/3.16/en/docs/user_manual/working_with_projections/working_with_projections.html#overview-of-projection-support
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4. Create a separate layer of your home country (or if you want more precise borders then 
download your country borders from GADM database) and project this into your home 
country’s zone. If your country falls into several zones, then map your home city. How does 
the map look like? Include a map of your home country in UTM projection into your 
Independent task report (see task 6). 

   

Task 6 – Independent task 
For the independent task report, make an overview of your home country’s national coordinate 
system:  
• Find out what horizontal and vertical Datum is used in your country and if and how it has changed 
through time. Give a short historical overview if possible. 
• What is the national projected coordinate system for your country – give the specifics, peculiarities, 
changes over time. 

In addition, include properly formatted (north arrow, scalebar, graticule (see in the end of the 
tutorial for guideline for graticule with coordinates) following maps of your country:  

1) location map of your home country in freely chosen equal-area projection suitable for the whole 
world from task 2; 

2) map of your home country in WGS84 coordinate system (note that your actual map will be 
showing Plate Carree); 

3) in your country’s projected national coordinate system (note that for this map the graticule units 
have to be metric e.g. meters or kilometres);  

4) in UTM from task 5. If your country’s national coordinate system is also UTM then make the 3rd 
map in regional coordinate system. For example, European regional coordinate system is known as 
ETRS89 which is using Lambert Azimuthal Equal Area (LAEA) projection. 

Example maps: 

https://gadm.org/data.html
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How to make a grid with coordinates? 

For adding a graticule with coordinates, you need to make the grid in Layout view. Once you add 
your map to the layout, then on the right side of the window there should be Item Properties 
tab open. Scroll down to Grids and click on the + button to add a new grid to the map. Now click on 
Modify Grid. Add grid with suitable interval, coordinates (you can adjust their orientation, format, 
coordinate precision etc.). 
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